4D SKOLAN pa Datorn I Utbildningens webbplats har en handledning med cirka 160 bilder att klicka
sig igenom for att skapa ett lappsynkat huvud med hjalp av det avancerade 3D programmet BLEN-
DER. Det har &r en kort sammanfattning av handledningen p& 4D SKOLAN.

Har hittar du Blender att ta ner GRATIS:
http://www.blender.org/download/get-blender/

Leta ocksd reda pa gratisprogrammen Audacity - for att spela in ljud och Gimp - for att skapa
bilder.

N&r du startat Blender ska du fa se ett 3D-fénster med en kub i mitten. Till héger om den en lam-
pa. Under lampan en kamera. Och du ser de tre objekten uppifran - fran Top vyn.

Under 3D fonster ett fonster med en massa knappar.
Du kan dra ner ett informationsfonster som finns gémt ovanfér 3D fonstret.
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Markera - View & Control och sen View Name och du ska fa se vilken vy som 3D fénstren visar.

Klicka System & Control och sen Emulate Numpad om din dator inte har ett siffertangentbord
sa kan du sen anvanda de vanliga siffertangenterna for att byta vy i ett 3D fonster.

Rulla MMB och du zoomar i en 3D-vy.
Hall ner MMB och dra och du roterar en 3D-vy.
TR TR s il i SHIFT + MMB och hall ner den dra och och du panorerar en

3D-vy.

MMB = Middle Mouse Button - alltsd hjulet pa en trek-
napparsmus.

Skapa en bild = rendera

Ga till menyns Render > Render Current Frame

eller F12 eller klicka Render knappen i Scene fonstret som
du f&r fram med F10.

I scenfonstret finns det ocksd knappar for att bestamma
storleken pa den renderade bilden.

Skapa fonster

Placerar du muspekaren i kanten pd ett fonster - mellan tva fonster sa dndrar
muspekaren utseende och du kan hégerklicka for att fa fram en meny och vélja
Split Areas for att sen bestdmma var ett fonster ska delas i tva. Med Join Areas
gor du tva fonster till ett.

Jain Areas

Mo Header

Med View knappen under ett 3D fonster s& kan du vélja vilken vy du vill visa i ett 3D
fonstret. Du kan tex ha en Topvy, en Camera vy och en User vy. Camera ger perspektiv
men Ortographic ar enklare att jobba i.

Hogerklickar du ndgot objekt - en lampa, kub, kamera s&8 markeras det och du kan flytta det ge-
nom att klicka G-tangenten, R for att rotera och S for att skala.
Efter att ha flyttat, roterat, skalat s bekraftar ett vansterklick vad du gjort.

G och sen X flyttar ndgot markerat bara i X-riktningen = vénster/héger
G och sen Y flyttar ndgot markerat bara i Y-riktningen = indt/utat
G och sen Z flyttar ndgot markerat bara i Z-riktningen = uppat/nerat

Esc-tangenten avbryter ett kommando. CTRL+2Z angrar nagot du utfért.



_;}\f"’ﬂ".‘. H&r &r kameran markerad och den har fatt tre pilar som du kan anvénda
\ for att flytta den endast i en viss riktning.

A Den roda pilen flytta i X-riktningen - vanster/héger
Y Den gréna pilen flytta i Y-riktningen - inat/utat

\ ~ Den bld pilen flytta i Z-riktningen - upp&t/nerat

; ) &
Visas inte pilarna s8 CTRL+mellanslag och du far fram en meny och du kan vélja Translate for att fa
se pilarna.

Med G-tangenten och sen X-tangenten flyttar du ocksa bara i X-riktningen.
R-tangenten och sen Z-tangenten och du roterar ndgot endast kring Z-axeln.
S-tangenten och sen Y-tangenten och du skalar ndgot endast i Y-riktningen.

5 ~ Du kan hégerklicka . I Object Mode sa flyttar
Dra.h.typ'e' kuben for att sen Val_]a Hude. du, roterar och skalar
& Textured hur du vill se den. & Weight Paint n&got tex en kub.

& Shaded ¥ Texture Paint Vill du férandrar ku-
ﬂ Verex Paint ben s& markera
; den(hdgerklicka den) for
£F Wirefram & Sculpt Mode att sen ga till Edit Mode.
(7 Bounding Box m TAB-tangenten vaxlar
" Kl Cihiect Mode ocksa mellan
= L — Object Mode och Edit
- o sis "= Mode och tillbaka.

T PAN @_J [l I Edit Mode kan man vélja pm man vill flytta pa kubens horn - kallas vertex
eller om man vill flytta pé dess kanter - kallas edges

1 = anim gller om man vill flytta kubens sidor - kallas faces.
verex select mode

A-tangenten markerar/avmarkerar allt - tex
alla faces.

W-tangenten tar fram en meny och du kan
valja Subdivide for att dela upp alla markerade
faces.

Anvand Subdivide tva ganger och du kan sen
skapa ett 6ra genom att markera ett face och
sen E-tangenten for att dra ut det - extru-

dera det.

Med SHIFT tangenten nere sa kan du hégerk-
licka tva faces fér att markera dem

och sen E-tangenten och vélja Region fran den
meny som kommer fram for att sen dra ut de
tva facen till en under- eller dverkake. Skapa
sen den andra kaken.

Forma 6ron och kakar genom att klicka G-tang-
enten for att flytta pa face(s) och S-tangenten
for att skala dem.

Med SHIFT se till att markera fyra faces pa
huvudets undersida. Sen E-tangenten for att
extrudera dem - skapa en hals.

CTRL+R och du kan ge halsen fler segment sa
att den gar att béja.

V- Med de fyra understa facen markerade sen
(1} Cube SHIFT+S och Cursor to Selection.




Tab-tangenten for att avsluta Edit Mode och g3 till Object Mode.
-~ F9 eller Edit knappen for att fa fram Edit fonstret. Och klicka

| o Editing (F3) |
|{} =|d KFF\N EI -2 ) Center Cursor knappen.

File > Save eller CTRL+W for att spara. Valj var du vill spara eller skapa en ny mapp.

F EAmy blend Save As

Namnge filen. Filtypen .blend behdver du inte ange. Men sparar du en bild s8 behéver du ange filtypen
tex .jpg For att spara behdver man klicka Save As tva ganger

""" Sare As
i;_ér? cel

Satt in ben i kroppen

Se till att du &r i Object Mode. Markera kroppen och klicka mellanslagstangenten
for att fran en meny valja Add > Armature for att fa ett ben. Flytta det till hal-
sens underkant om det hamnat fel. Ga till Edit Mode och vélj den 6versta delen
av benet for att ge benet en langd lika med halva halslangden.

Se till att 6versta delen av benet ar valt och klicka sen E for att skapa ett nytt
ben - ge det en viss ldngd - s& det hamnar under huvudet. Skapa ytterligare ett
ben som gar upp till huvudets dversida.

X-Ray knappen visar benet framfor kroppen i Solid Mode.

Auto IK knappen fér att kunna flytta det ben du skapat sist och fa de andra be-
nen att félja med i flytten.

Envelopes knappen se till att den inte ar markerad.

Hogerklicka ett ben for att markera det och ga till Pose Mode for att testa.
G-tangenten och du kan flytta benet. Esc-tangenten avbryter. CTRL+Z &ngrar.
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Ga till Object Mode.

Hoégerklicka for att valja kroppen. SHIFT+hégerklicka for att ocksa vélja benen.

CTRL+P for att fa en meny och vélja Armature och sen Don 't Create Groups.

Hogerklicka ett ben for att vélja benen och ga till Pose Mode.

Hégerklicka kroppen och ga till Weight Paint Mode.

N-tangenten tar fram Weight Paint menyn. Valj Weight 1, Opacity 1, Spray men inte Soft. Hogerklicka
ett ben och rédmala de delar av kroppen som du vill ska paverkas av benet. Malar du fel s3 Weight 0
och mala det bldtt som blev fel.

G-tangenten och du kan testa om kroppsdelen fdljer benet. Esc-tangenten avbryter.

Valj ett nytt ben och mala. Fortsatt med det tredje benet.

Ga till Object Mode. Hégerklicka ett ben och ga till Pose Mode och testa om kroppen féljer benen.



Dags att animera
Se till att skapa tre eller fyra fonster. Ett Camera fonster, ett 3D fonster, ett fonster med Video Sequen-
ce Editor(VSE) och Action Editor fénstret.

T = Taa T8 Editing (Fg) I st i
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Klicka Edit knappen eller F9 ¥ 1=l

Add Shape Key | [EETTINNN

Valj Shapes fliken. Klicka Add Klicka Add Shape Key och du
Shape Key och du far en key som  far en ny Key kallad Key1. Dép
kallas Basis. Den ska du alltid utga om den till ndgot lampligt. Jag

ifran nér du skapar nya Shape dopte den till mouthopenclose.
Keys.

Klicka TAB-tangenten nar du ar dver modellen for att byta till Edit Mode.

SHIFT+hogerklicka for att vélja tva faces i underkéken for att stdinga munnen. Och likadant med tva
face i 6verkaken.

TAB-tangenten for att ga till Object Mode.

Vélj Basis Key for att sen klicka Add Shape Key och du far en ny key som du kan dépa till ndgot 1amp-
ligt. Jag dopte den till mouthtwist.

Ga till Edit Mode och som tidigare vélj tva face i nagon av kakarna och twista till munnen.

Ga till Object Mode och experimentera genom att styra munnen med de tva sliders.
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Se till att skapa ett nytt fonster - det fjarde fonstet - ett Camera fonster.

I Video Sequence Editorn(VSE) klicka Add knappen for att vélja Audio(HD) och leta reda p& en kort
ljudfil med tal. Jag hade skapat en ljudfil med orden:

"Hello World! How are you doing?” och sparat filen som mono - 16 bits - 44 kHz - 128 kbs. Placera ut
ljudfilen langs tidsaxeln.

F10 eller klicka Scen knappen.

Vé&lj Render fliken for att sen frén

Format vélja FFMpeg. Och skriv in efter End - hur manga rutor du vill anvanda till animationen. Valj
Audio fliken for att sen valja Codec: MP3

IR [#E.0 kA2 ][ Recale | Sound Block knappen for att sen markera Sync och Scrub. Sen
s kan du flytta dig langs tidsaxeln och f8 munnen att rora sig till

1 TIfELI'I'I'ITIh'I r Ijudet.
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Hogerklicka ett ben och ga till Pose Mode. I Video Sequence Editorn g
till forsta rutan. Anvand G for att flytta ett valt ben och R for att rotera
det. I-tangenten for att fa fram en meny och vélja LocRot for att fa en

nyckelbildsruta - en ruta som Blender anvénder for att lagga pa minnet
var benen finns och hur de ar roterade. select Pose |@Poe Mo o o0




Klicka UP-tangenten for att flytta 10 rutor framat. Anvand G och R for att skapa en ny pose. I-tangen-
ten for att vélja LocRot och fa en ny nyckelbildsruta. Fortsitt sen genom att hoppa 10 rutor framat.

I Object Mode klicka ALT+A for att spela upp och fa se resultatet - fa se hur Blender automatiskt rak-
nar ut hur benen ska flyttas mellan nyckelbildsrutorna.

Se ocksa3 till att animera munnen/kaften s& den synkar till ljudet. Flytta langs tidsaxeln for att lyssna
pa ljudet. Anvéand de tva Sliders fér att 8ppna/stdnga munnen - twista till den - fér att fa nagon slags
kaftsynk till ljudet. Opnna munnen p3 vokaler som A och O. Stang den melllan orden.
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Markera modellens kropp. Sen F9 eller Edit
knappen. I Edit Mode klicka A-tangenten for
att valja alla faces i modellen. Fliken Link
and Materials och du kan klicka New for att
sen vélja ndgon firg och sen Assign.
Avmarkera sen alla faces - klicka A-tangen-
ten.

Valj New och en ny farg tex svart for att
sen markera flera faces i 6gon och mun

- hall ner SHIFT-tangenten fér att markera
flera faces. Och sen Assign. Resultatet en
karaktar med farg med svarta 6gon och
med insidan av munnen ocksa svart. £1) ol - maitelt

Edit Button. Modifiers fliken. Add Modifier
- valj Subsurf och sen Levels: 2 och Set
Smooth.
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e For att spara animationen som en video-fil klicka RENDER knappen.

REMDER
Elender Internal g
‘mﬂmm ﬁ Anim fliken och Do Composite.
A

Do Seguenc

Format fliken och vélj tex PAL som ger 720 pixels pa
bredden och 576 pixels pa héjden.

'-mﬁ:nrmat
|Game framingy settings Pl
| i |v| MNTSC
. Sizex: 720 |« SizeV: 576 —
Farmat Freset
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A Eil’ﬂ.’a’[E.' output file format _EIEE 2
|“ Min Rare o= ize 1792

| Max Rate 9000 | |[Mus PSize 2048 |

Audio fliken och Multiplex Audio

Farmat it

Stamp

Anim fliken och se till var videofilen ska sparas och
vad den ska heta.

| Touch [Mo Orveerwrite |

tm-"-"-l’lll'l'l W Klicka Anim knappen eller g3 till

Render > Render Animation

AN \
You TIII]E Fron dwtde A nglish
Do Seguenc poadeast oursalf Home Videas
Do Composi Guide - ett talande huvud - Blender handledning

Efter lite vantan pd att alla rutorna ska ha rende-
rats s& ska du ha fatt en videofil som du kan skicka
upp till tex YouTube.com fér att fa en varldspu-
blik!!!

Beratta din historia - fa ndgon - nagra att titta och
lyssna - kanske géra egna historier - svara pa din
historia. Fa igdng ett globalt samtal i animerad 3D!
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